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Abstract— Burn tragedy is a significant hazard to 

human life and properties. Automatic fire alarm device 

allows for real-time tracking, monitoring and intimation.  

Once the fire happens, it gives early warning and helps to 

the fire loss. It is versatile security and alarm system which 

can be used by individuals, corporations or industrial 

establishments. The concept behind this project is to have 

a quick, easy, accurate and low-cost fire sensing and 

location-intimating device for users to get support in 

critical situations. The system can be positioned at any 

remote location that the consumer can quickly access with 

the aid of GSM technology. In this it is proposed that 

NodeMCU acquire signals from different sensors and 

control to manage communication with property owner. 

This is carried out by sending SMS immediately to owner 

in initial stage and to fire brigade in critical stage to 

resolve fire hazard.  Different sensors incorporated within 

system are   smoke, fire and flammable gas sensor. It helps 

to estimate specific threshold values in hazardous 

condition and alarms the buzzer accordingly. If in high 

emergency the system sends SMS consisting of the area 

and address location to the user / in charge person and fire 

brigade respectively. 

      Keywords- Node-MCU (ESP8266), Smoke sensor, Flame 

sensor, Temperature and Humidity sensor, GSM 

 

 

I.  INTRODUCTION  

Wherever heat sources and flammable materials share a room, 

possibilities for fire occur. Many industrial sites contain highly 

hazardous content which can combust or burst into flames 

unless adequately handled and processed. An industrial fire is 

a form of industrial disaster which causes enormous damage to 

its sector. There are different ways in which this hazard is 

caused such as electrical fire, flammable liquids, compressed 

gases, hot work, housekeeping practices etc. The work 

environments in every industry pose unique fire hazard hence 

there lies some general issues culminating in a risk of fire or 

blast in industrial complexes or manufacturing facilities. 
Prevention ensures that a minor event or a small fire in a trash 

does not turn into a catastrophic event which can devastate a 

business or the lives of workers and a community.  

Fire prevention is based on various hazard monitoring systems 

that include: Linear heat detection, Smoke Detection, CO and 

Combustible Gas detection, Emissions monitoring and many 

others with technological developments, fire safety issues also 

have raised rapidly. Few researchers have tried to overcome 

this hazard monitoring in different ways viz. review of fire-

detector types has been carried out by Omar Asif et.al. with 

development of microcontroller based automated fire alarm 

system for alerting fire incidents in household or industrial 
premises [1]. While Chen Thou et al. [2] worked on the early 

fire detection through image processing. The basic idea behind 

fire-detection was RGB (red, green, blue) model based 

chromatic and disorder measurement for extracting fire-pixels 

and smoke-pixels. Based on iterative checking on the growing 

ratio of flames, a fire-alarm was given when the alarm-raising 

condition is met.  In other studies an emergency response 

system for fire hazards was designed with IoT standards for 

rescue operations for public safety by Ravi K. et.al.[3]. The 

system to improve home safety by getting immediate response 

about fire was implemented by Mahzan N. N. et.al.[4] while 
GSM based fire alarm system is suggested by Mao and Duan 

[5].  Lian used   controller  to get remote  alarm for fire system 

[6]. This paper proposes framework of low cost multi sensor 

and alarm system with intimation of actual hazard location. To 

take precautionary measure and to avoid fire hazards or 

destruction especially in industrial setup this system has been 

developed. This works in two possible steps.  First step is to 

inform the owner about the fire initiating signal so as to alert 

and to get in action whatsoever required. And the second step 

is to alert instantly to fire fighters also in case fire broke out 

exceeding threshold values. 

II. SYSTEM COMPOENTS 

A. NodeMCU 

Node-MCU is an open-source firmware and development 

kit that helps to build prototype. It includes firmware 

which runs on the ESP8266 Wi-Fi SoC from Espressif 

and hardware which is based on the ESP-12 module. It 

uses an on-module flash-based SPIFFS file of Systems. It 
is asynchronous and event-driven. Many functions, 

therefore, have parameters for callback functions.  

The ESP8266 Node-MCU has total 17 GPIO pins broken 

out to the pin headers on both sides of the development 
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board. These pins can be assigned to all sorts of 

peripheral duties, including: A 10-bit ADC channel, 

UART interface, PWM outputs, SPI, I2C & I2S interface, 

I2S interface  etc. 

 

The programmable ROM is programmed on-board via the 
USB, allowing the programming step to be easily integrated 

into the product manufacturing and testing process. 

Maintaining the Integrity of the Specifications 

 

B. SIM900A Modem (GSM) 

SIM900A Modem is built with Dual Band GSM from 
SIMCOM. It works on frequencies 900 / 1800 MHz. The 

frequency bands can also be set by AT Commands. The baud 

rate is configurable from 1200-115200 through AT command. 

It is ultra compact and wireless module and allows connecting 

PC as well as microcontroller with RS232 Chip. It is suitable 

for SMS, Voice as well as DATA transfer application in M2M 

interface.  It provides facility for audio calls and SMS attend 

the incoming calls through simple AT commands. This is a 

complete very powerful single-chip with serial and TTL 

outputs.  

 

C. Data Acquisition Sensors 

There are four different components for acquiring data from 

the site. 

 

1) Temperature & Humidity Sensor 
Ambient temperature and humidity is measured using DHT11 

air temperature humidity sensor. The DHT11 is a basic, ultra 
low-cost digital temperature and humidity sensor. It uses a 

capacitive humidity sensor and a thermistor to measure the 

surrounding air, and spits out a digital signal on the data pin. 

Its fairly simple to use, but requires careful timing to grab 

data.  And new data collected from it once every 2 seconds. 

 

2)  Flame Sensor 

Flame sensor is a device used to detect the presence of fire in 

its surrounding. For this system we have used Infrared Flame 

Sensor to detect the fire. It consists of a photodiode coated 

with black epoxy which makes it sensitive to the infrared 

radiations having wavelength between 700nm to 1mm and can 

detect fire up to distance of 100cm within 60 degrees of angle 

of detection. Detection process is based on the Infrared (IR) 

wavelength emitted by the flame. 

  

3) MQ2 Gas Sensor  
It is metal oxide semiconductor sensor used for sensing the 

concentration of gases in the air. It comprises a sensing 

material whose resistance improves as it comes into contact 

with gas. This change in the value of resistance is used for the 

detection through voltage divider network. It can detect 

Propane, Hydrogen, Methane etc concentrations in the range 

of 200 ppm to 10000 ppm. 

 
 

4) MQ5 Gas Ssensor 
This sensor detects the presence of gas in an area. This module 

is useful for gas leakage detection of LPG, Natural gas, town 

gas and or smoke etc. Use the onboard potentiometer to adjust 

the sensitivity. 

 

5)  Relay module 
A relay switch is operated by an electromagnet which requires 
a small voltage for activation which is provided from the 

NodeMcu. When any one input from the sensor sense above 

threshold limit, relay switch activates bulb to switch ON. It 

helps to show emergency status of hazards area.  

 

 Assembling all these components together makes a system, as 

shown in block diagram figure 1 

 

 
                               Fig. 1.  System block diagram 
 

III. SYSTEM OPERATION 

A. Hardware 

The actual circuit connection is shown in figure 2. In this 

circuit two main components are used. One is NodeMCU and 

other GSM module. Sensors are interfaced with NodeMCU as 

input devices while the GSM will execute process after getting 

signal from NodeMCU. The relay circuit will be activated for 

alarming fire hazard to switch ON bulb and buzzer sounding. 
The circuit connection shows NodeMCU powered by Boost 

Buck module. Different sensors for detection are connected 

through this module for power requirements. The entire sensor 

devices are interfaced with NodeMCU as input devices.   

Flame sensor acts as electromagnetic radiation receiver. This 

sensor uses the infrared flame flash method, which allows the 

sensor to work through a coating of oil, dust, water vapor. 

While the smoke detection sensor MQ2 is used to detect the 

gases like methane, propane, concentrations if any present.  

This sensor includes a sensing part, primarily ceramic based 

on aluminum oxide, filled with Tin dioxide, embedded in a 
mesh of stainless steel.  When immersed in air at high 

temperatures, oxygen is adsorbed on the surface of the sensing 

material. Instead donor electrons in tin oxide are drawn to this 

oxygen and hence the present flow is stopped. Such oxygen 

atoms interfere with the reduction of pollutants, thus reducing 

the surface density of the adsorbed oxygen when pollutants are 

present. Current will now pass via the sensor, producing 

https://www.elprocus.com/voltage-divider-rule-with-examples/
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analog voltage values. The quantities of these voltages are 

calculated to determine the gas concentration. Tension levels 

are higher when gas production is small. MQ5 is responsible 

for detecting smoke. The gas sensor module consists of an 

exoskeleton in steel that houses a sensing device beneath it. 

By connecting leads this sensing aspect is subject to current. If 
a gas interacts with this sensor, it is first ionized and then 

adsorbed by the sensing part. This changes the resistance of 

the sensing element which alters the value of the current going 

out of it. This adsorption creates a potential difference on the 

element which is conveyed to the NodeMCU unit through 

output pins in form of current. DHT11 sensor consists of a 

capacitive humidity sensing element and a thermistor for 

sensing temperature.  The humidity sensing capacitor has two 

electrodes with a moisture holding substrate as a dielectric 

between them. Change in the capacitance value occurs with 

the change in humidity levels. This tests the modified 

principles of resistance and transforms them into digital shape. 
This sensor uses Negative Temperature coefficient of 

thermistor to measure the temperature, which causes its 

resistance value to decrease with increase in temperature. This 

sensor typically consists of semiconductor ceramics or 

polymers to achieve a greater resistance value except with the 

slightest temperature shift. The messaging GUI is designed for 

sending warning SMS. Sim900 interacts on UART platform 

with external device. The default Contact baud rate is 9600 

bps. This requires setup and functional AT commands for it. 

NodeMCU Serial UART is used to interface the 

communication with sim900. Arduino IDE is used to compile 
and compose code. In the serial channel initialization feature 

is initialised. AT commands are sent to GSM in loop function. 

Note the cell number type to which the SMS must be 

submitted. The power is kept for ever at the end of the loop 

process while(1) process. If while(1) is not present, the loop 

feature runs continuously and SMS are continuously sent to 

the recipient. 

 

 
                   

Fig. 2. Circuit Connection diagram 

B. Software 

This is preliminary step to begin with programming – need to 

initiate the system with following steps. 

 Connect Node MCU to computer. Need a USB micro 

B cable to connect the board. 

 Open Arduino IDE and Install ESP8266 board. 

Require at least Arduino IDE version 1.6.4 to 

proceed with this. Go to File > Preferences. In the 

"Additional Boards Manager URLs" field, type 

http://arduino.esp8266.com/stable/package_esp8266c

om_index.json, then click OK. 

Then go to Tools > Board > Board Manager. Type 
"esp8266" in the search field  

The entry "esp8266 by ESP8266 Community" should 

appear. Click install button. 

 Select NodeMCU 1.0:  Tools->Board dropdown 

Config the Board menu and choose the right Port for 

your device. CPU Frequency：80MHz, Flash 

Size：4M（3M SPIFFS), Upload Speed：115200, 

Now the system is ready for coding. 

C. Experimental setup and Flow sequence 

The figure 3 shows actual experimental set up for the low cost 

automatic fire alarm and hazard location intimating system for 

industrial application. The component working is explained in 

hardware section.  

 

 
        Fig. 3. Experimental setup of sensing system 

  

The flow sequence of detection and alerting system is shown 

in flow diagram figure 4. 

D. Flow description 

As shown in flow diagram (figure 4) at the initiation, 

controller checks for interface connectivity. If it finds ok, first 

SMS about activation is transferred through GSM module to  

 

http://arduino.esp8266.com/stable/package_esp8266com_index.json
http://arduino.esp8266.com/stable/package_esp8266com_index.json
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Fig. 4. Flow diagram 

owner’s mobile. Each sensor is set to threshold limit. 

Controller checks the threshold value at preset time interval. 

Once initiation process is completed Sensor starts its function 

to detect. It gives logic 1 as output if any threshold limit is 

crossed otherwise its output remains in logic 0. NodeMCU 

continuously monitors these logical variations at output pin of 
sensor.   

 

At any instance if the threshold value exceeds, sensor detects 

it and signals to NodeMCU. Message is sent to owner and 

warning indicators are activated, here buzzer and bulb. If more 

than one sensor exceeds threshold limits NodeMCU performs 

necessary actions to activate relays for the buzzer and bulb. At 

the same instant alert message is also sent to user and fire 

brigade about emergency.  The beauty of this system is that 

fire fighter receive message with the address of hazardous area 

too. This enables them to directly track the spot for preventive 

actions. The address is stored in memory of the installed 
device to avoid major losses in such hazardous conditions by 

instantly informing fire fighters team. 

                                       

IV.  RESULTS 

 Tests were performed with differing conditions of smoke, air, 

and temperature to evaluate the system's efficiency and 

reaction to adverse fire circumstances. The results of the tests 

indicate that the program consistently provides appropriate 
warning responses under different test conditions. Figure 5 

shows the experimental setup of the tests, where it indicates 

the condition of the bulb ON. And the system responses in the 

form of SMS under different situations to the owner and fire 

fighter are shown in Figure 6a & 6b, respectively. Throughout 

the experiments, the system's transmission period from fire 

detection to warning message (SMS) via GSM network was 

on average 15 seconds for the owner as well as the fire fighter, 

which is fast enough to take the appropriate steps to stop the 

fire threat. 

 

 

 
 

Fig. 5. Indication Bulb ON detecting fire possibility 
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Fig. 6aAlerting SMS reached to owner 

 

 

 
                     

 

Fig. 6b.  Alerting SMS reached to Fire fighter with location 

intimation 

 

V. CONCLUSION 

Fire tragedy presents a great threat to human life and property. 
In view of this a   low cost automatic fire alarm and hazard 

location intimating system for industrial application is 

designed and implemented. NodeMCU being the significant 

controller comes in action whenever signals from sensors are 

received and act accordingly to communicate with GSM 

module to send SMS. Also it activates relay module to blow 

buzzer alarm at the local site area. This 

system provides an early fire warning which will help to 

prioritize the immediate rescue operations by owner and or 

fire fighters respectively so that damages will be reduced 

effectively. 
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